SolidWorks®
2015

SolidWorks Composer Hands-on Test Drive
The information and the software discussed in this document are subject to change without notice and are not commitments by Dassault Systemes SolidWorks Corporation (DS SolidWorks).

No material may be reproduced or transmitted in any form or by any means, electronically or manually, for any purpose without the express written permission of DS SolidWorks. The software discussed in this document is furnished under a license and may be used or copied only in accordance with the terms of the license. All warranties given by DS SolidWorks as to the software and documentation are set forth in the license agreement, and nothing stated in, or implied by, this document or its contents shall be considered or deemed a modification or amendment of any terms, including warranties, in the license agreement.

**Patent Notices:**

SolidWorks® 3D mechanical CAD software is protected by U.S. Patents 5,815,154; 6,219,049; 6,219,055; 6,611,725; 6,844,877; 6,898,560; 6,906,712; 7,079,990; 7,477,262; 7,558,705; 7,571,079; 7,590,497; 7,643,027; 7,672,822; 7,688,318; 7,694,238; 7,853,940, 8,305,376, 8,351,902, and foreign patents, (e.g., EP 1,116,190 B1 and JP 3,517,643).


**Trademarks and Product Names for SolidWorks Products and Services:**

SolidWorks, 3D ContentCentral, 3D PartStream.NET, eDrawings, and the eDrawings logo are registered trademarks and FeatureManager is a jointly owned registered trademark of DS SolidWorks.

CircuitWorks, FloXpress, PhotoView and TolAnalyst are trademarks of DS SolidWorks.


Other brand or product names are trademarks or registered trademarks of their respective holders.

**COMMERCIAL COMPUTER SOFTWARE - PROPRIETARY**

The Software is a "commercial item" as that term is defined at 48 C.F.R. 2.101 (OCT 1995), consisting of "commercial computer software" and "commercial software documentation" as such terms are used in 48 C.F.R. 12.212 (SEPT 1995) and is provided to the U.S. Government (a) for acquisition by or on behalf of civilian agencies, consistent with the policy set forth in 48 C.F.R. 12.212; or (b) for acquisition by or on behalf of units of the department of Defense, consistent with the policies set forth in 48 C.F.R. 227.7202-1 (JUN 1995) and 227.7202-4 (JUN 1995).

**Copyright Notices for SolidWorks Standard, Premium, Professional, and Education Products:**

Portions of this software © 1986-2013 Siemens Product Lifecycle Management Software Inc. All rights reserved.

This work contains the following software owned by Siemens Industry Software Limited:

D-Cubed™ 2D DCM © 2013. Siemens Industry Software Limited. All Rights Reserved.


Portions of this software © 1998-2013 Geometric Ltd.

Portions of this software incorporate PhysX™ by NVIDIA 2006-2010. Portions of this software © 2001-2013 Luxology, LLC. All rights reserved, patents pending.

Portions of this software © 2007-2013 DriveWorks Ltd.

Copyright 1984-2010 Adobe Systems Inc. and its licensors. All rights reserved.

Adobe, the Adobe logo, Acrobat, the Adobe PDF logo, Distiller and Reader are registered trademarks or trademarks of Adobe Systems Inc. in the U.S. and other countries. For more DS SolidWorks copyright information, see Help > About SolidWorks.

**Copyright Notices for SolidWorks Simulation Products:**

Portions of this software © 2008 Solversoft Corporation.

PCGLSS © 1992-2013 Computational Applications and System Integration, Inc. All rights reserved.

**Copyright Notices for SolidWorks Enterprise PDM Product:**

Outside In® Viewer Technology, © 1992-2012 Oracle © 2011, Microsoft Corporation. All rights reserved.

**Copyright Notices for eDrawings Products:**

Portions of this software © 2000-2013 Tech Soft 3D.

Portions of this software © 1995-1998 Jean-Loup Gailly and Mark Adler.

Portions of this software © 1998-2001 3Dconnexion.

Portions of this software © 1998-2013 Open Design Alliance. All rights reserved.

Portions of this software © 1995-2010 Spatial Corporation.

The eDrawings® for Windows® software is based in part on the work of the Independent JPEG Group.


Portions of eDrawings® for iPad® copyright © 2003 - 2005 Apple Computer Inc.
Using This Book

As the title implies, this book is a hands-on experience. You will be using SolidWorks® Composer and experiencing many of the major capabilities of SolidWorks Composer very quickly. You will be learning by doing. Once you start up SolidWorks Composer, you will be working with models and images for the rest of the book that you will create. This book is just a guide.

Before you Begin

SolidWorks Composer files that have been included for your use are loaded to the SolidWorks Composer Test Drive folder on your system. This book is written with the assumption that you will also save your files in the same folder.

About the Author

David Planchard is the founder of D&M Education LLC. Before starting D&M Education, he spent over 28 years in industry and academia holding various engineering, marketing, and teaching positions and degrees. He holds five U.S. patents and one international patent on equipment design. He has published and authored numerous papers on Machine Design, Product Design, Mechanics of Materials, and Solid Modeling and has co-authored over 40 SolidWorks publications in the past ten years. David holds a BSME, MSM with the following Professional Certifications: CCAI, CCNA, CCNP, CSWA, and CSWP. David is a SolidWorks Solution Partner and an Adjunct Faculty member at Worcester Polytechnic Institute in the Mechanical Engineering department.
Using This Book ........................................................................................................... 5
Before you Begin ................................................................................................... 5
About the Author.................................................................................................... 5
The SeaBotix LBV150 ................................................................................................. 3
Notes: ............................................................................................................................ 4
Goal of this Test Drive ................................................................................................. 5
What is SolidWorks Composer Application? ............................................................... 6
Understanding the Workflow ....................................................................................... 7
Notes: ............................................................................................................................ 8
SolidWorks Composer Getting Started ........................................................................ 9
SolidWorks 2015 Composer User Interface (UI)................................................... 10
Ribbon ........................................................................................................... 10
Assembly Pane ................................................................................................ 10
Collaboration Pane ..................................................................................... 10
Views Pane ...................................................................................................... 10
Viewport ........................................................................................................ 11
Properties Pane ................................................................................................... 11
Workshops Pane .............................................................................................. 11
Timeline Pane ................................................................................................... 12
Status Bar ........................................................................................................... 12
Pop-ups and Short-cut Toolbars ................................................................ 12
Leveraging CAD data .......................................................................................... 13
Notes: ..................................................................................................................... 14
Starting SolidWorks Composer and Opening an Assembly....................................... 15
Navigating 3D Data.............................................................................................. 16
Modifying the Environment and Orientation..................................................... 17
Views in SolidWorks Composer ......................................................................... 19
Creating Views..................................................................................................... 20
Rendering Tools in SolidWorks Composer ....................................................... 21
Rendering Tools ................................................................................................ 22
Modifying Ground Effects and Lighting........................................................... 25
Selection Sets ...................................................................................................... 27
Creating the Selection Sets................................................................................... 28
When you complete this book, you will have experienced firsthand an introduction to the capabilities of SolidWorks® Composer including:

- Basic operations such as navigating and annotating your CAD data
- Understanding the power of creating technical illustrations
- Publishing high-resolution raster graphics images
- Publishing vector graphics images
- Producing interactive and configurable 3D assembly animations
- Updating CAD geometry
- Publishing graphical content into Manufacturing Work Assembly Instructions
The SeaBotix LBV150

During this hands-on session, you will use SolidWorks Composer to create technical communications used in manufacturing work assembly instructions, service procedures, product manuals, and marketing collateral of the SeaBotix LBV150 assembly shown below.

SeaBotix, Inc. designed, manufactured, and introduced the first lightweight, low-cost, fully production submersible, remotely operated vehicle, the Little Benthic Vehicle (LBV). Bringing this breakthrough product to a wider market required modern technical communication tools.

The company selected SolidWorks® Composer software for its ease of use and ability to leverage 3D CAD data to create clear, dynamic product images and animations across all their technical communications.
SolidWorks Composer Hands-on Test Drive

Notes:
**Goal of this Test Drive**

Your goal for this test drive is to use SolidWorks Composer to improve the quality of the SeaBotix LBV 150 manufacturing work assembly instructions and service procedures. You will perform the following tasks:

- Create a parts list suitable for technical illustrations in assemblies
- Provide high-quality images for manufacturing work assembly instructions
- Create a clear 3D animation that depicts a service procedure
- Update your images and animations to easily reflect design changes
What is SolidWorks Composer Application?

SolidWorks Composer revolutionizes the way that you can create product communication deliverables. Intelligent views and animations convey complex product procedures using a minimal amount of text.

SolidWorks Composer publishes 2D and 3D output from 3D CAD data. To save time, you leverage existing 3D CAD data. The data can come from any major 3D CAD software application including SolidWorks, CATIA, PTC ProE/Creo, Inventor, Spatial Technology and other neutral 3D formats.

You do not need any CAD knowledge or training to use SolidWorks Composer.

SolidWorks Composer exports industry-standard file formats including:

- 2D high-resolution raster images: TIFF, JPG, PNG and BMP
- 2D vector graphics images: SVG and CGM
- 3D content: PDF, HTML, and AVI
- Other output: email, 3DVIA.com

SolidWorks Composer permits you to document the product while it may still be under development, helping to lower cost and improve time to market. Through CAD data associativity, SolidWorks Composer allows you to later update all deliverables without the need to re-work them. SolidWorks Composer requires no programming skills or other specialized capabilities to produce any of its output formats.
Understanding the Workflow

The workflow of SolidWorks Composer is as follows:

1 Convert Files
Open 3D CAD data from any CAD application. You can directly open some CAD files in their native file format, such as a SolidWorks Assembly (.sldasm) or CATIA V5 Assembly (.CATproduct).

You can also open CAD files in a number of neutral file formats such as IGES (.igs), STEP (.step) and ACIS (.sat). Neutral CAD file formats are comparable to text files (.txt) in word processing applications.

2 Create Content
Imagine you want to take a photograph. Before taking the picture, you would prepare the subject of the photograph and the background scenery. This is analogous to what you do in SolidWorks Composer. As the author of the content, you prepare and animate to display the 3D CAD data in the desired manner.

3 Publish Content
After you easily create views and animations, you publish and save images and animations into one of the supported file types. Your customers, service technicians, and manufacturing operators can experience your 3D output as User Manuals, Technical Illustrations and Web Content.

4 Incorporate Design Changes
You can easily update your views and animations when CAD data changes allowing you to start content creation early in the design process.
Notes:
**SolidWorks Composer Getting Started**

To get started, let’s review the SolidWorks Composer User Interface. The application is divided into a number of panes.

You will see how easy it is to open CAD data from SolidWorks in SolidWorks Composer and then manipulate the geometry to create views while exploring the SolidWorks Composer environment.
SolidWorks Composer Hands-on Test Drive

SolidWorks 2015 Composer User Interface (UI)

The SolidWorks 2015 Composer User Interface (UI) is designed for easy access to all the functions that interact with your geometry in a 3D scene.

Ribbon

The Ribbon provides access to many functions of SolidWorks Composer.

Assembly Pane

The Assembly pane lists model parts and assemblies, collectively known as geometry actors, that are imported from CAD files.

Collaboration Pane

The Collaboration pane lists annotations, markups, and other enhancements, collectively known as collaborative actors, that you add to your model.

Views Pane

The Views pane displays thumbnail images of views, which are snapshots of your geometry and collaborative actors.
Viewport

The Viewport is the large graphics area where the view displays the 3D scene. In the Viewport, you interact with the geometry and the collaborative actors.

Properties Pane

The Properties pane lists properties of selected actors.

Workshops Pane

The Workshops pane provides access to feature sets, such as publishing raster and vector images and Bill of Materials (BOM).
SolidWorks Composer Hands-on Test Drive

Timeline Pane

The Timeline pane lets you create and view 3D animations.

Status Bar

The Status bar displays instructions for using commands and provides access to several useful functions.

Pop-ups and Short-cut Toolbars

SolidWorks Composer also contain Pop-ups and Short-cut toolbars. As you right-click on the Ribbon, view or in other sections of the UI, corresponding functions are displayed.
Leveraging CAD data

Let’s start by opening the SolidWorks MiniGrab assembly file from the SeaBotix LBV150. You will perform some basic SolidWorks Composer operations and get familiar with the User Interface.
Notes:
Starting SolidWorks Composer and Opening an Assembly

1. Start the SolidWorks Composer application.
   - Double-click **SolidWorks Composer 2015** from the Desktop interface.

2. Open a File.
   - Click **File», Open
   - **Browse** to the SolidWorks Composer Test Drive\SeaBotix folder.
   - Select **SolidWorks (default)** from the Import profile drop-down menu.
   - Select **SolidWorks Assembly(.sldasm)** for Files of type.
   - Double-click **MiniGrab Assembly** for Name.

3. Save a copy of the File.
   - Click **File», Save As**.
   - **Browse** to SolidWorks Composer Test Drive folder. MiniGrab Assembly is the SolidWorks Composer filename.
   - Click **Save**.

**Note:** The Save command saves the document into the current folder. The Save As command allows you to Browse to a different folder location.

**Note:** The Import meta-properties option transfers metadata from your CAD model, such as Part No, Description and user defined properties, into SolidWorks Composer.
Navigating 3D Data

SolidWorks Composer files display 3D data as an assembly of actors. You can change the view orientation of these assemblies. Methods include:

- Zoom in and out to look more closely at the assembly. Double-click an actor to zoom to the selected actor, and roll the mouse wheel to zoom in and out.
- Pan to move the assembly. Hold down the mouse wheel while dragging the mouse.
- Rotate to observe the assembly from different orientations. Hold down the right mouse button while dragging the mouse.

The Compass in the upper right corner of the Viewport helps orient you in 3D. The red, green, and blue axes indicate the X, Y, and Z directions, respectively. As you rotate the model, the Compass rotates to reflect the change. You can click the axes and faces of the Compass to rotate the model into that orientation.

The Collaboration pane provides easy access to display the Compass and Ground in the SolidWorks Composer Environment. Modify the view background environment to a white background and no ground.
Modifying the Environment and Orientation

1  **Modify the Environment.**
   - Click **Collaboration** tab.
   - Click in the **white area** of the Viewport.
   - Click the **White color square** for Foot color in the Properties pane.
   - Expand the **Environment** folder from the Collaboration pane.
   - UnCheck **Ground**.

2  **Use the Compass.**
   - Click the **Normal Y** axis to view the top of the assembly.
   - Click the **Normal Y** axis again to view the bottom of the assembly.
   - Click the **Normal Z** axis to view the front of the assembly.
3 Rotate the assembly.
   - Hold the **right mouse button** down and drag to rotate the assembly approximately as shown below.

4 Pan the Assembly.
   - Hold down the **middle mouse wheel** and drag to pan the assembly to the center of the Viewport.

5 Zoom to Fit.
   - Double-click in the **white background** of the Viewport to zoom to fit to see the entire assembly.
Views in SolidWorks Composer

Views represent an intelligent snapshot of the actors. Views remember the properties and visibility of all the parts of the assembly and annotations. Views also remember the orientation of the camera, the position of the parts in an Exploded view, and the properties of the Viewport.

Creating views with the proper appearance and position of all the actors is important for quality 2D output. Once your views are setup properly, then getting quality 2D output occurs by setting only the proper output options.

To display a view in the Viewport, either double-click the view or drag the thumbnail image from the tab into the Viewport.

For the MiniGrab Assembly, create six views to capture the appearance of the assembly:

- Default
- Step 1
- Step 2
- Step 3
- Exploded View
- Parts List

Begin with the Default view.
Creating Views

1. **Create a New View.**
   - Click the **Viewport Mode** button to switch to the View Mode.
   - Click the **Views** tab.
   - Click **Create View** from the Views pane. A thumbnail image of the view appears in the Views pane.

2. **Rename the View.**
   - Click the **View name box**.
   - Enter **Default** for View name.
Rendering Tools in SolidWorks Composer

SolidWorks Composer includes rendering tools that modify the appearance of the model and apply visual effects. You can toggle the visibility of the edges and switch from shaded to silhouette mode. You can apply visual effects common in technical illustrations for manufacturing work assembly instructions and service procedures.

With SolidWorks Composer, selecting render options is an easy one click operation.

In the next section, you will create views and explore rendering tools, modes, ground effects and lighting effects.
SolidWorks Composer Hands-on Test Drive

Rendering Tools

1. **Select a Rendering Mode.**
   - **Zoom in** rotating the middle mouse wheel on the 3 Jaws part as illustrated.
   - Click the **Render** tab.
   - Click the **Mode** drop-down menu. View your rendering options.
   - Select **Technical**.
2 **Create a Technical View.**
   - Click **Create View** from the Views pane. A thumbnail image of the view appears in the Views pane.

3 **Rename the View.**
   - Click the **View name box**.
   - Enter **Step 1** for View name.

4 **View the Back Seal Screw.**
   - **Rotate** and **Zoom in** on the back Seal Screw as illustrated.
5 **Select a Rendering Mode.**
   - Click the **Render** tab.
   - Click the **Mode** drop-down menu. View your rendering options.
   - Select **Silhouette**.

6 **Modify the Outline Style.**
   - Click **Outline Style** drop-down menu.
   - Select **Construction Edges**.
   - Click **Outline Style** drop-down menu.
   - Click **Smart Outlines**.
   - Click **Outline Style** drop-down menu.
   - Click **Sharp Edges**.

7 **Create a New View.**
   - Click **Create View** from the Views pane.

8 **Rename the View.**
   - Click the **View name box**.
   - Enter **Step 2** for View name.
Modifying Ground Effects and Lighting

1. **Modify Ground Effects.**
   - Double-click **Default** from the Views pane.
   - Click **Ground** from the Render tab to show ground.
   - Click **Shadow** to show ground shadow.
   - Click **Mirror** to show ground mirror.
   - Deselect **Grid**.

2. **Turn off Ground Effects.**
   - Deselect **Ground**.
3 **Select an Actor.**
   - Click the **Main Housing** in the Graphics area.
   - Drag the **Opacity Slider** to the left in the Properties pane.

4 **Select the Lighting tools.**
   - **Zoom in** on the MicroGrab Electronics Board.
   - Click **Per Pixel** to enable per-pixel lighting.
   - Click **Ambient Occlusion** to enable Ambient Occlusion.

5 **Create a New View.**
   - Click **Create View** from the Views pane.
   - Click the **View name box**.
   - Enter **Step 3** for View name.

6 **Display Default View.**
   - Double-click the **Default** in the Views pane.

7 **Save the file.**
   - Click **Save**.
Selection Sets

With SolidWorks Composer you can combine different actors together to create Selection Sets. Selection Sets save time, especially in creating Exploded views of sub-assemblies.

In the next section, you will create the Jaw_Bushings Selection Set that combines all 3Finger Jaw, Jaw bush, and Micro_Grab Pivot Pin parts.

Later you will manipulate the Jaw_Bushings Selection Set to create the MiniGrab Exploded view.
Creating the Selection Sets

1. Create the actors to group.
   - Click the **Assembly** tab.
   - Hold the **Ctrl** key down.
   - Click the three **3Finger Jaw** parts.
   - Click the six **Jaw bush** parts.
   - Click the six **Micro_Grab Pivot Pin** parts.
   - Release the **Ctrl** key. The selected parts are displayed in the Assembly pane.
2. Apply the Tooltip Property.
   - Drag the split bar upwards.
   - Click the Name box in the Tooltip Property.
   - Click MiniGrab Assembly (level 1).
SolidWorks Composer Hands-on Test Drive

1 **Create Selection Set.**
   - Drag the **split bar** downwards to display the Assembly pane.
   - Click **Create Selection Set** from the Assembly pane.
   - Enter **Jaw_Bushings** for Selection sets name.

2 **Display the Selection Set.**
   - Click the **Jaw_Bushings** Selection set in the Assembly pane. The Jaw_Bushings Selection Set is displayed in the Assembly pane.

3 **Deselect the Selection Set.**
   - Click in the **white area** of the Viewport.
Creating An Exploded View

An Exploded view shows the parts of an assembly separated by a distance. Exploded views are common in manuals showing placement of parts. Typically, Exploded views are associated with Bill of Materials (BOMs) and callouts to indicate the files in the parts list.

Different methods exist in SolidWorks Composer to create Exploded views. You can drag selected actors individually to a new position. You can use linear, cylinder, or spherical explode to automatically space the actors in their new position.

Here is an Exploded view of the MiniGrab sub-assembly of the SeaBotix LBV 150 assembly.

In the next procedure, you will use the transform, linear and cylindrical explode tools to separate actors from the main assembly to create an exploded view.
Exploding the Seal Screw and End Cap Plug

1  **Explode the Seal Screw.**
   - Zoom in on the **back Seal Screw** as illustrated.
   - Click **Transform** tab.
   - Click **Translate**.
   - Click the **Seal Screw** as illustrated.

2  Click and drag the **Green arrowhead** of the Triad backward.
3 Explode the End Cap Plug and Seal Screw.
   - Zoom out to view the back **End Cap Plug** as illustrated.
   - Hold the **Ctrl** key down.
   - Click the **Seal Screw** in the Viewport.
   - Click the **End Cap Plug** in the Viewport.
   - Release the **Ctrl** key.
   - Click and drag the **Red arrowhead** backwards as illustrated.
4. **Explode the Main Housing.**
   - **Zoom out** to view the total assembly.
   - Click the **Main Housing** in the Viewport.
   - Click and drag the **Blue arrowhead** backward as illustrated.
SolidWorks Composer Hands-on Test Drive

5 Exploding the Jaw_Bushings Selection Set
   - **Zoom out** to view the total assembly as illustrated.
   - Click **Assembly** tab.
   - Click **Jaw_Bushings** Selection set from the Assembly pane.
   - Click and drag the **Red arrowhead** to the lower right corner of the Viewport.
Linear Exploding the Internal Components

1. Select the Internal Components.
   - Window-select the internal components of the Main Housing in the Viewport as shown.

2. Space the Assembly Components.
   - Click Linear from the Transform tab to explode all selected actors.
   - Click and drag the Red double arrowhead towards the Jaw_Bushings.
   - Click and drag the Red double arrowhead backwards.
Exploding the Selection Set

1 **Select the Micro Grab Pivot Pins.**
   - Click inside the in the **white area** of the Viewport.
   - **Zoom in** on the Jaw_Bushings Selection Set as illustrated.

2 **Translate two Actors.**
   - Click **Translate** on the Transform tab.
   - Click the first **Micro Grab Pivot Pin**.
   - Hold the **Ctrl** key down.
   - Click the second **Micro Grab Pivot Pin**.
   - Release the **Ctrl** key.
   - Hold the **Alt** key down.
   - Click on the top face of one **Micro Grab Pivot Pin** to align the **Blue arrowhead** with the normal direction of the top face.
   - Click and drag the **Blue arrowhead** forwards.
Repeat the above procedure for the remaining four **Micro Grab Pivot Pins**.

**View** the final results below.
3. Select three 3 Finger Jaws.
   - Click **Cylindrical** from the Transform tab.
   - Click the first 3 Finger Jaw in the Viewport.
   - Hold the Ctrl key down.
   - Click the second and third 3 Finger Jaw in the Viewport.
   - Release the Ctrl key.
   - Click and drag the Red arrowhead towards the right to cylindrically rotate all three actors.
Creating the Exploded View

1. Create the Exploded View.
   - Double-click in the **white area** of the Viewport.
   - **Zoom out** to view the total assembly as illustrated.
   - Click the **Views** tab.
   - Click **Create View** from the Views pane.
   - Enter **Exploded View** for View name.

2. Save the View.
   - Click **Save**.

**Tip:** To return to the collapsed position, click Restore Neutral Position.
Creating a Parts List in SolidWorks Composer

Your next task is to create a parts list for both print and online use. You will add a Bill of Materials (BOM) table, insert callouts and create a Parts List view.

With SolidWorks Composer, you can publish a vector graphics image of your parts list using the Technical Illustration workshop. A key benefit of vector images is that they can be scaled to any size without losing image resolution.

From the Technical Illustration workshop, save your Part List view as a .SVG file. The .SVG file type can be opened in Internet Explorer to create an interactive experience between the parts list and actors (components) in the Exploded view.

<table>
<thead>
<tr>
<th>Description</th>
<th>BOM ID</th>
<th>Qty</th>
</tr>
</thead>
<tbody>
<tr>
<td>3 Prong Jig</td>
<td>1</td>
<td>1</td>
</tr>
<tr>
<td>3 jaw Mounting Tip</td>
<td>2</td>
<td>1</td>
</tr>
<tr>
<td>3 jaw Push Tip Bracket</td>
<td>3</td>
<td>1</td>
</tr>
<tr>
<td>3/8-16 Fastener</td>
<td>4</td>
<td>1</td>
</tr>
<tr>
<td>3/8-16 Locknut</td>
<td>5</td>
<td>1</td>
</tr>
<tr>
<td>3/8-16 Locknut</td>
<td>6</td>
<td>1</td>
</tr>
<tr>
<td>3/8-16 Locknut</td>
<td>7</td>
<td>1</td>
</tr>
<tr>
<td>3/8-16 Locknut</td>
<td>8</td>
<td>1</td>
</tr>
<tr>
<td>3/8-16 Locknut</td>
<td>9</td>
<td>1</td>
</tr>
<tr>
<td>3/8-16 Locknut</td>
<td>10</td>
<td>1</td>
</tr>
<tr>
<td>3/8-16 Locknut</td>
<td>11</td>
<td>1</td>
</tr>
<tr>
<td>3/8-16 Locknut</td>
<td>12</td>
<td>1</td>
</tr>
<tr>
<td>3/8-16 Locknut</td>
<td>13</td>
<td>1</td>
</tr>
<tr>
<td>3/8-16 Locknut</td>
<td>14</td>
<td>1</td>
</tr>
<tr>
<td>3/8-16 Locknut</td>
<td>15</td>
<td>1</td>
</tr>
<tr>
<td>3/8-16 Locknut</td>
<td>16</td>
<td>1</td>
</tr>
<tr>
<td>3/8-16 Locknut</td>
<td>17</td>
<td>1</td>
</tr>
<tr>
<td>3/8-16 Locknut</td>
<td>18</td>
<td>1</td>
</tr>
<tr>
<td>3/8-16 Locknut</td>
<td>19</td>
<td>1</td>
</tr>
<tr>
<td>3/8-16 Locknut</td>
<td>20</td>
<td>1</td>
</tr>
</tbody>
</table>
Create a Parts List

1. **Activate the BOM Workshop.**
   - Click the **Workshops** tab.
   - Click **Show/Hide BOM Workshop**.
   - Select **Visible geometry** for BOM IDs Apply to.
   - Select **SW Component Name** for Property name.
   - Click **Generate BOM IDs**.
2 Modify the BOM Position.
   - Click the BOM table at the bottom of the Exploded View.
   - Select Free for Position Placement.

3 Position the BOM.
   - Drag the right top corner of the BOM to the left side of the Exploded View.
   - Drag the BOM boundary to enlarge the text and table size.

4 Save the model.
   - Click Save.
Creating Callouts

1. **Create the Callouts.**
   
   - Window-select all **actors** in the Exploded view.
   - Click **Create Callouts** from the BOM Workshop.

2. **Modify the Callout alignment.**
   
   - Select **Top** from the Auto alignment Properties.
Assigning BOM ID Manually and Sequentially

1  Create the BOM IDs Manually.
   - Click **Assign Manually** from the BOM Workshop.
   - Click the rightmost **callout**. The BOM ID 1 is displayed.
   - Click the **callout** to the left. The BOM ID 2 is displayed.
   - Repeat the **sequence** to the left.

2  Create a view.
   - Click the **Views** tab.
   - Click **Create View** from the Views pane.
   - Enter **Parts List** for View name.
   - Click **Save**.

Note: Use Magnetic Lines to align your BOM IDs along a diagonal line.
Publishing the Parts List

1. Activate the Technical Illustration workshop.
   - Click Technical Illustration Workshop from the Workshops tab. The Workshop pane is displayed.

2. Publish the Image.
   - Select HLR(high) for Profile.
   - Click Save As.
   - Enter Parts List for File name. Select .SVG(svg) for Save as type.
   - Browse to the SolidWorks Composer Test Drive folder.
   - Click Save.
3 Close the Technical Illustration Workshop.
   - Click **Close** in the upper right corner of the Workshop pane.

4 View the file in Internet Explorer.
   - **Browse** to the SolidWorks Composer Test Drive folder.
   - Double-click **Parts List.svg**.
   - Position your mouse on the **Gearbox** from the BOM table. The Gearbox is displayed in green.

5 Close the Parts List and MiniGrab Assembly.
   - Click **Close** Parts List.svg in Internet Explorer.
   - **Close** the MiniGrab Assembly.smg in SolidWorks Composer.

6 Save the model.
   - Click **Save**.

**Note:** Hyperlink names in your BOM Table to open individual components in your assembly through the Link Property.
Developing Views for Manufacturing Work Assembly Instructions

Manufacturing Work Assembly Instructions illustrate your product’s work flow, namely how parts go together, the fastening process, the manual steps performed by the assembler, and the automated steps performed by equipment.

With SolidWorks Composer, you can development Manufacturing Work Assembly Instructions, even before your design starts production. Views created in SolidWorks Composer are automatically updated when changes are made to the associated engineering models.

In the next procedure, you will create three new views for the SeaBotix LBV150 Manufacturing Work Assembly Instructions. Open the SolidWorks Composer SeaBotix LBV150.smg. Create and modify views that represent the step-by-step instructions.

Later, you will link new view images to the SeaBotix LBV150 Manufacturing Assembly Instructions Word document.
SolidWorks Composer Hands-on Test Drive

Notes:
Opening a SolidWorks Composer File

1 Open a File.
   - Click File, Open.
   - Browse to the SolidWorks Composer Test Drive folder.
   - Double-click SeaBotix LVB150.smg for File name.

2 Save a Copy of the File.
   - Click File, Save As.
   - Enter My SeaBotix LBV150 for File name.
   - Click Save.

3 Activate the View.
   - Click the Views pane.
   - Double-click Default.
Creating a View for Manufacturing Assembly Instructions Cover

1  **Create a View.**
   - Click Create View from the Views pane. A thumbnail image of the view appears in the Views pane.

2  **Rename the View.**
   - Enter Cover Image for View name.
Using the High Resolution Image Workshop

The High Resolution Image Workshop of SolidWorks Composer generates raster graphics images. Raster graphics images accurately show subtle changes in lighting, shading, or coloration of the model. Supported file types include: .bmp, .jpg, .png and .tif.

Using the High Resolution Image Workshop, you can control settings for the published output, including:

- The size of the image
- Anti-aliasing effects
- The background of the image

In the next procedure, you use the High Resolution Image tool to create a JPEG file for the cover image.
SolidWorks Composer Hands-on Test Drive

Notes:
Publishing a High Resolution Manufacturing Assembly Instructions Cover

1. **Activate the High Resolution Image Workshop.**
   - Click **High Resolution Image** from the Ribbon. The High Resolution Image pane is displayed.

2. **Set options.**
   - Click **Anti-aliasing** to smooth the edges of the assembly.

3. **Publish the image.**
   - Click **Save As** in the High Resolution Image pane.
   - **Browse** to the SolidWorks Composer Test Drive folder.
   - Enter **Cover Image** for File name.
   - Click **Jpeg (.jpg, .jpeg, .jpe)** for Save as type.
   - Click **Save**.
4 **Preview the image.**
   - **Open** Windows Explorer.
   - **Browse** to SolidWorks Composer Test Drive Folder.
   - Double-click **Cover Image.jpg**.
   - **Minimize** the Windows and return to SolidWorks Composer.

5 **Close the High Resolution Image Workshop.**
   - **Maximize** SolidWorks Composer window.
   - **Click** Close.

6 **Save the file.**
   - **Click** Save.
Creating Additional Views for Manufacturing Assembly Instructions

There are a number of views that represent the steps in the Manufacturing Assembly Instructions. The assembly instructions involve installing hardware to fasten the shells of the SeaBotix LBV 150 assembly.

As you review the Views pane, you can see Step 1 through Step 9. There are two missing views, Step 4 and Step 5.

Create two views that illustrate Step 4 and Step 5 and then link them to your SeaBotix Manufacturing Assembly Instructions Word document.

For Step 4, change Properties and use Annotations Arrows.

For Step 5, create a Detailed view with the Digger tool.
SolidWorks Composer Hands-on Test Drive

Notes:
Creating a View and Applying Annotations

Manufacturing Assembly Instructions Procedure Step 4 fastens two M4x20 screws to secure the shell. SolidWorks Composer includes a number of tools to markup views, annotate views, and measure actors. These are arrows, images, labels, call outs, dimensions and more. These tools are called collaborative actors.

Start with the existing Step 1 to create Step 4. Rotate the view to clearly see the two screws. These two screws are the actors in your view. Modify the color of the screws and insert arrows.

Note: You can align the arrow to any edge by holding down the Alt key and hovering over the desired edge before placing the arrowhead.
Preparing for the Manufacturing Assembly Instructions Step 4

1. Create the View, Step 4.
   
   a. Double-click **Step 1** from the Views pane.
   
   b. **Rotate** and **Zoom in** to view the two top M4x20 screws.
   
   c. Click **Create View**.
   
   d. Enter **Step 4** for View name.
   
   The two M4x20 screws are the actors in the view, Step 4. Change the color property of the screws and insert two arrows.
Changing Color

1 Select two screws.
   - Click the left screw as illustrated.
   - Hold the Ctrl key down.
   - Click the right screw as illustrated.
   - Release the Ctrl key.

2 Modify properties.
   - Click the bright yellow color square in the Color bar of the Properties pane. The two screws turn yellow.
Adding Arrows

1. Add two Arrows.
   - Click the **Author** tab.
   - Click **Arrow** in the Markups group.
   - Click the head of the **left screw** to start the arrow.
   - Click a **position** above the assembly to end the arrow.
   - Click the head of the **right screw** to start the arrow.
   - Click a **position** above the assembly to end the arrow.
   - Press the **Esc** key to deselect the Arrow tool.

   - Hold the **Ctrl** key down.
   - Click **both arrows**.
   - Release the **Ctrl** key.
   - Drag the **Opacity slider** all the way to the right as illustrated.

3. Update the View.
   - Click **Update View** in the Views pane.

4. Save the View.
   - Click **Save**.
Creating a View and Applying the Digger

In Manufacturing Assembly Instructions Step 5, you are required to document how to insert the M4x50 Pan Head Screw. It is difficult to document the correct screw in a photograph. With SolidWorks Composer, use the Digger tool to clearly indicate the correct screw.

The Digger is patented technology that allows you to zoom in on different areas of the model, peeling away actors to see what is behind them and much more.

Use the Spacebar to turn on the Digger.

In the next procedure, you create a new view, Step 5. Apply the Digger to create a detail view of the screw to be installed. You will also insert an image of a screwdriver to indicate the manufacturing operation.
SolidWorks Composer Hands-on Test Drive

Notes:
Preparing for the Manufacturing Assembly Instructions Step 5

1  **Create the View, Step 5.**
   - Double-click **Step 1** from the Views pane.
   - **Rotate** to view the Pan Head Screw at the back of the shell.
   - Click **Create View**.
   - Enter **Step 5** for View name.

2  **Add a Detail View.**
   - Click the **white area** of the Viewport to locate the Digger.
   - Press the **Spacebar** to activate the Digger.

3  **Display the Digger tools.**
   - Click **Show/Hide Tools** to display the Digger tools. View the results.
4 Change the Focus.
   n Drag the Change Center of Interest tool to the Pan Head Screw. The Pan Head Screw appears in the center of the Digger circle.

5 Modify Detail View Scale.
   n Drag the Percentage handle around the Digger circle to change the zoom scale. View the results in the Viewport.
6 Create a Detail view.

- Click **Capture Picture in 2D Image**. The Digger closes and a 2D circular image appears in its place.
Adding an Image

1. Display the Image Library.
   - Click the Home tab.
   - Click High Resolution Image from the Ribbon.
   - Select Image Library from the Workshops pane.

2. Add the Image.
   - Drag the i_screw.bmp into the white area of the Viewport.
3 Update the View.
   - Click **Update View** in the Views pane.

4 Save the View.
   - Click **Save**.
Inserting into the Manufacturing Assembly Instructions Document

The SeaBotix LBV150 Manufacturing Assembly Instructions document uses views you created in SolidWorks Composer. The document was created in Microsoft Word. Now you will publish all your views in high resolution and insert hyperlinks to the document. To save steps, publish all the views at one time to create high resolution images. You do not require all the view in the Manufacturing Assembly Instructions manual, but it is easier to discard a few images than to create many individual images.
SolidWorks Composer Hands-on Test Drive

Notes:
Publishing All Images

1. **Activate the High Resolution Image Workshop.**
   - Click **High Resolution Image** from the Ribbon. The High Resolution Image pane is displayed in the Workshops pane.

2. **Set options.**
   - Click **Anti-aliasing** to smooth the edges of the assembly.
   - Click **Multiple** tab.
   - Click **Views** to select all the views.
3 Publish all Images.
   - Click **Save As** in the High Resolution Image pane.
   - **Browse** to the SolidWorks Composer Test Drive folder.
   - Enter **SeaBotix LBV150** for File name prefix.
   - Click **Jpeg (.jpg, .jpeg, .jpe)** for Save as type.
   - Click **Save**.

SolidWorks Composer saves all views as high resolution .jpeg images with the prefix SeaBotix LBV150.

4 Close the High Resolution Image Workshop.
   - **Maximize** SolidWorks Composer window.
   - Click **Close**.

5 Save the SolidWorks Composer file.
   - Click **Save**.
Linking Images in Microsoft Word

1 Open the Microsoft Word document.
   - Browse to the SolidWorks Composer Test Drive folder.
   - Double-click the SeaBotix LBV150 Manufacturing Assembly Instructions document.

2 Insert a Picture.
   - Click in the empty cell to the left of Step 4.
   - Click Insert, Picture from the Word Main toolbar.
   - Select SeaBotix LBV150_Step 4.jpg.
   - Click the Insert drop-down menu.
   - Select Insert and Link.
3. **Resize the Picture.**  
   - Click and drag the corner **drag handle** to resize.

4. **Insert a Picture.**  
   - Click in the empty **cell** to the left of Step 5.  
   - Click **Insert, Picture** from the Word Main toolbar.  
   - Select **SeaBotix LBV150_Step 5.jpg**.  
   - Click the **Insert** drop-down menu.  
   - Select **Insert and Link**.
5  **Resize the Picture.**
   - Click and drag the corner **drag handle** to resize the picture.

6  **Complete the Word document**
   - Repeat insert picture for the **SeaBotix LBV150_Cover.jpg** as illustrated. Do not move the picture on the cover at this time.
   - Right-click in the **cover** picture.
   - Click **Wrap Text.**
   - Click **Square** to position the image in the center of the page. Move cover picture if needed.

7  **Save and Close the Word document. Return to SolidWorks Composer.**
   - Click **Save.**
   - Click **Close.**
SolidWorks Composer Hands-on Test Drive

Notes:
Incorporating Design Changes

SolidWorks Composer gives you the ability to incorporate design changes into your work. You can easily update parts with geometry from updated 3D CAD files. With SolidWorks Composer, you can also add or delete parts as assemblies are modified.

You no longer have to retake all of the digital photos of your service manual or screen shots for your Manufacturing Assembly Instructions. When you use SolidWorks Composer, the latest design changes made by your design and engineering teams propagate to your 2D views and 3D animations.

The functionality of SolidWorks Composer gives you full control over when to incorporate geometry changes and part additions or deletions, and only requires access to the updated 3D data (SolidWorks Composer files, 3D CAD files or other supported 3D file types). The 3D CAD files are not modified using SolidWorks Composer.

The images below show a before and after look at the SeaBotixLBV150 assembly. Notice the addition of a support rib to the side bumper. This is a fictitious change made by the design team to strengthen the side bumper.

Over the next few pages, you will update the assembly, then publish all of the view to create the images to update your Manufacturing Assembly Installation procedure.
Updating the Assembly

1. Update the assembly in SolidWorks Composer.
   - Double-click Default view.
   - Click File, Update, SolidWorks Composer document.
   - Select SeaBotix LBV150_rev2.smg in the SolidWorks Composer Test Drive folder.
   - Click the Update button to view the design changes.
2 Publish all Images.

- Click High Resolution Image from the Ribbon.
- Click Multiple tab.
- Click Views.
- Click Save As in the High Resolution Image pane.
- Browse to the SolidWorks Composer Test Drive folder.

- Enter SeaBotix LBV150 for file name. The file names must be the same to update in the Manufacturing Assembly Instructions document.
- Click Save.
- Click Yes.

3 Close the Workshops pane.

- Click Close.
Updating Links in Microsoft Word

1. Open the Microsoft Word document.
   - Browse to the SolidWorks Composer Test Drive folder.
   - Double-click SeaBotix LBV150 Manufacturing Assembly Instructions document. View the updated Cover and Steps.
2 **Broken Links.**
   If the Links do not update, then perform the next steps.
   - Click **File**.
   - Click **Info**.
   - Click **Edit Links to Files**.
Hold the Ctrl key down. 
Select all files. 
Release the Ctrl key. 
Click Update Now.

3 View the updated document. 
Review Step 4 and Step 5. The design changes are updated.
Using 3D Animations in Service Procedures

A good animation tells a story and can replace lines of text and many 2D images. Seeing objects move and change in a 3D animation is a clear way to describe Manufacturing Assembly Instructions and Service Procedures.

Animations in SolidWorks Composer can include:

- Camera view changes. Assemblies can zoom, pan, and rotate.
- Position changes. Geometry actors can explode and collapse. Collaborative actors can move to another area of the view.
- Property changes. Geometry actors can change color, highlight as their emission property changes, and disappear as their opacity property changes. Collaborative actors can change size, appear and disappear and have new text.
- Digger changes. Instances of the Digger can change size, position, center of interest and so on.

In the next procedure, you play and enhance an existing animation. You see all of the aspects of an animation (camera view, position, property, and Digger changes). This animation simulates a Service procedure using a series of 2D images.

To save time, reuse and rename views and images created in the Manufacturing Assembly Instructions procedures to create a Service Procedures. Begin by opening SolidWorks Composer SeaBotix LBV150 Service Procedure.
SolidWorks Composer Hands-on Test Drive

Notes:
Play and Modify an Existing Animation

1. Open a SolidWorks Composer File.
   - Click File, Open.
   - Browse to the SolidWorks Composer Test Drive folder.
   - Double-click SeaBotix LVB150 Service Procedure for File name.
2 **Switch to Animation mode.**
   - Click the *Animation* icon in the Ribbon.

3 **Play the animation.**
   - Click **Play** on the Timeline toolbar to view the actors.

4 **Stop the animation.**
   - Click **Stop** on the Timeline toolbar.

5 **Modify the Timeline.**
   - Click **Rewind** to start at 0 seconds.
   - Click and drag a red rectangle on the timeline.
   - Drag the red triangle until **Step 1** moves to approximately 2 seconds.
6 Insert a new view.
   n Click and drag the Exploded View onto the Timeline toolbar at 0 seconds.

7 Use the Markers pane.
   n Right mouse click the Ribbon to add the Markers pane.
   n Click Step 1 on the Markers pane to advance the Timeline to Step 1.

8 Add an Image Widget to the viewport.
   n Switch to the Image Library Workshop.
   n Select the Widget folder.
   n Click and drag the Play button to the lower left corner of the viewport to create an interactive button.
9 Add the interactivity.
   - Select the Play button and set Pulse as 200ms on the Event Property pane.
   - Click the right corner of the Link property to bring up the Select a link dialog and choose Play Marker Sequence from the URL Drop-down menu.
   *Note:* you can link to other file types or views as well as external websites.
   - Select Step 1 From the Address Drop-down menu and click Ok.
   - Click Step 2 from the Markers pane and change the link on the properties panel to Step 2.
   - Repeat for Steps 3 and Step 4.
10 Create additional steps of the animation manually.

- Click the **Forward** button to reach the end of the existing animation.
- Select the **RightSide** selection set on the Assembly tab.
- Set a **Key** by clicking the red **Set Keys** button.

Move the timeline to around 27 seconds.

- Translate the selected models (**RightSide**) up.
- Click the Previous button to reach the previous key.
- Set the **Pulse** as 200ms on the **Event property** pane.
- Open up the **Event Link** dialog
- Select **Play** in the URL drop-down menu and **Current Position** in address drop-down menu.
SolidWorks Composer Hands-on Test Drive

11 Play the animation.
   - Exit the Design Mode and Play the entire animation.
   - Notice the animation stops at all the markers and the right side selection. It will wait till you click to proceed.

12 Save the document.
   - Save the document to keep all the changes.
   - This is the end of the section on Animation.

Congratulations! You have finished the SolidWorks Composer Hands-on Test Drive.

Notes: